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Report on Imaging Instructional Materials being worked on November 2002

The attached materials are lecture and laboratory modules that are being developed to 
enhance the imaging content of our electro-optic sequence. These materials were used 
last semester [ Spring 2002 ]. Modifications and additional laboratory experiences are 
being developed this semester.

Original Files are being developed in "Mathcad" a "MathSoft" product.  It was decided 
to use "Mathcad" as a laboratory analysis tool for these modules because it allows the 
student to see both the image result and the numerical manipulations performed upon 
the image matrix.

All of the attachments have been printed as adobe PDF files so that the contents of 
these instructional files can be accessed by individuals not having the Mathcad 
software.

To prepare students for this portion of the course sequence the course structure 
introduces Mathcad early in the semester this insures proficiency with the software's 
basic functions prior to encountering these modules.

These attached modules are:

Lecture Materials Chapter Nine which is one of two "Chapters" that form part of the 
text materials used throughout the Electro Optics course:

Chapter 9 Image Detectors 
Chapter 10 Color Images

Laboratory Materials Laboratory One which is one of five laboratory exercises

Laboratory Exercise One Explores the structure and modification of a Gray Scale 
image. Files are:
L1
L1_Theory
L1_Example

Laboratory exercises that are under development include:

Laboratory Exercise Two Used in spring of 2002 and being modified. Drills concepts 
developed in Laboratory One and introduces the structure and modification of an RGB 
color image. Files are:
L2
L2_Theory
L2_Example
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Laboratory Exercise Three Used in spring of 2002 and being modified. Drills concepts 
developed in exercises one and two and introduces ASCII code. Files are: 
L3
L3_Theory
L3_Example
L3_Example_Decode

Laboratory Exercises Four and Five use cameras and materials purchased during 
the late spring and summer of 2002. These exercises are under development, both will 
involve the use of a CCD camera to acquire and analyze images. Accuracy of 
measurement and the comparison of pre-laboratory predictions to observed and 
measured results will be the skills developed. Laboratory Four will demonstrate the 
measurement of a diffraction pattern formed on a "bare" CCD sensor. Laboratory Five 
will be a more conventional camera with lens measurement of a physical object.

Materials developed by William J. Mooney, Professor Optical Technology, Monroe 
Community College Rochester NY
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Chapter 9 Image Detectors

Introduction:

An image detector is an array of detectors that are similar in many respects to a 
simple radiation detectors. These detectors are generally quantum detectors with a 
quantum efficiency less than one and a limited line width. Each individual detector 
will produce a signal that is proportional to the total radiation that is incident on it 
within its line width. One detector represents the smallest resolvable feature of the 
image that falls on the array. This smallest element is called a pixel. The examples 
below are intended to help you develop a sense of what a pixel is, and how pixel 
size relative to image size affects the fidelity of the rendered image. In all cases below 
we will assume that the display device has infinite resolution, and pixels of zero 
physical dimension!  All distortions will be due to the resolution of the image 
detector. 

Example Images:

A simple inverted V will be used as the illustrative image.  The inverted V 
being opaque and the surrounding area transparent.

Inverted V to be
projected onto a Pixel

detector plane

The first image will be the result of projecting the inverted V onto an image detector 
which has four detecting elements. Notice in the image below that the image is 
optically formed on the image plane with great fidelity. Problems in fidelity of 
reproduction will arise not from the optical system but rather from the pixel limitations. 

The top two detectors or pixels have a much larger portion of their surface 
illuminated than do the bottom two detectors. We can expect that  the top two 
detectors will produce a larger signal. This signal will be reproduced as a digital 
number in binary format.
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A common image format is *.bmp. In this format each pixel in a two dimensional 
array is assigned an eight bit binary number. The largest decimal number possible in 
this format that starts at zero is 255. 

2
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2
6

+ 2
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+ 2
4

+ 2
3

+ 2
2

+ 2
1

+ 2
0

+ 255.000= Or 2
8

256.000=

In this system 255 represents white and 000 represents black. All other numbers 
represent successive shades of gray. There are 256 possible levels.

Inverted V projected
on a Four Pixel
detector plane

Most area
illuminated will

yield a high
number

The image 
when 
projected on a 
four pixel array 
causes the 
matrix d1x 
illustrated 
below.

d1x
230

198

230

198









=

When this matrix is reproduced on an image display device it looks like this: 
Note the inactive areas between detectors have been ignored in creating the 
displayed image.

Not a very good 
rendition of the 
original image, 
even though the 
optically formed 
image was perfect.
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We can try and improve the image fidelity by creating a detector with more and 
smaller pixels. If we divide each of the original four in half,  both horizontally and 
vertically, we will have a sixteen pixel array.

Inverted V
projected on a
Sixteen Pixel

detector plane

The sixteen pixel array will 
produce the matrix d2x 
below.

d2x

255

255

251

230

248

166

92

220

248

166

92

220

255

255

251

230















=

This matrix will result in the image shown below. Fully 
illuminated pixels yield a value of 255 partially shaded pixels 
yield lower numbers representing different shades of gray

We are still clearly a long 
ways from having enough 
resolution to produce a 
good rendition of the 
original shape.
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If we again divide all pixels in half, both vertically and horizontally, we will have an 
array with 256 pixels, 16 per side. This will result  in the improved, but far from 
perfect, rendition below. The problem is not the total number of pixels but rather the 
total number of pixels available to reproduce the image of interest. In this case 
somewhat less than 144 of the 256 pixels are involved in actually detecting image 
information. The remainder are empty white space. In any imaging application the 
real issue is the number of pixels needed to reproduce the primary features of the 
image formed on the plane of the detector.

For high fidelity 
rendition, a pixel 
should be no larger 
than one percent of 
the smallest horizontal 
or vertical dimension 
of the major features 
of the projected 
images. 

The original inverted V image was designed so that the base of each leg is one sixth 
of the total image width. Good rendition would require a width of 600 pixels or an 
array with: 360, 000 pixels.

The *.bmp image used at the top of this document has a resolution of 728 by 728 
pixels or 530 ,000 total pixels.

The smaller the image detail is the greater the number of sub detectors required 
on an image plane to resolve the detail. 

Suppose you had a satellite in an orbit 5 km ( 3.1 mi ) above the surface of the 
earth with an angle of view of 10 deg. This system would resolve a field of view of 
about 437 meters radius, an area of 0.6 km2. If you wanted to resolve objects of 
one meter you would need a detector with more than 7.6 *109 elements! Spy 
satellites can be effective but they will not be cheap!
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The frame rate problem is quite similar to the rate at which you can take 
pictures with a conventional photographic film based camera. You have some 
finite exposure time and then a time to wind exposed film out and new film in. 
The frame rate is similar, you must "expose" the detector, readout the values 
and reset the detector to zero. 

As detector size increases the time required to read the pixel values also increases. 
This controls the "frame rate" of the detector. The frame rate is the total time 
required to obtain the image and includes exposing the detector long enough for it 
to respond and then reading the pixel values out into the attached digital system. A 
512 x 512 array with a 2 MHz readout rate can only run about eight frames per 
second. 

4096 4096⋅ 1.678 10
7

× pixel=

2048 2048⋅ 4.194 10
6

× pixel=

1024 1024⋅ 1.048576 10
6

× pixel=

512 512⋅ 2.621440 10
5

× pixel=

256 256⋅ 6.553600 10
4

× pixel=

Image detectors are built in multiples of 256 elements for practical reasons having to 
do with digital coding. This leads to the sizes listed below:

Note: 100 elements per meter

number of detector 
elements

N 7.654 10
9

×=N 2 r⋅
100

m
⋅









2

:=

field of viewarea 0.601 km
2

=area π r
2

⋅:=

projected radiusr 437 m=r 5 km⋅ tan
10 deg⋅

2








⋅:=

Calculations to verify the above assertions:
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The readout and reset time generally far exceed the required exposure time and 
numerous schemes are used to try and speed up read outs. Unfortunately many 
of these schemes use up surface area on the image plain and so degrade the 
image. In the drawings above you will note that there are spaces between the 
pixel elements and any information that falls on these spaces is lost. The "fill 
factor" is an important parameter of a detector array. Fill factor is the percentage 
of the array area given over to active detector surface. Fill factors of above 90% 
can be obtained at the expense of readout time. Very fast arrays often have fill 
factors less than 45% and so there is a trade off between frame rate and image 
fidelity.

Detector types:

The most common type of detector is the Charged Coupled Device CCD. 
The pixels on these devices are quantum detectors that convert incident 
photons to electrons and store them as an electric charge. The pixels are 
capacitors and the have quantum efficiencies that approach 100%. This of 
course means that incident power at long wavelengths causes a much bigger 
response that will incident short wavelenght energy. Like diode radiation 
detectors some sort of filtering is needed if a "flat" color response is desired. 
When the image is read out the capacitors are "discharged" to prepare for 
the next exposure. A shutter is used during the charge readout stage.

The material used determines effective detector line width with the same types of 
materials being used for CCD arrays as are used for diode detectors. Silicon is 
most common and used for the range 380 nm to 1100 nm which includes the 
visible. 

Near IR detectors are fabricated out of platinum silicide PtSi, indium antimonide 
InSb. Some of these detectors are CCD arrays while others use diode arrays. 
With the arrays available, images can be acquired between 1500 nm and 30000 
nm; just not with the same array! Arrays have also been constructed using 
microbolometers; where the readout circuitry reads the change in resistance, very 
wide spectral line widths and flat responses can be obtained with this technology.

Every sort of optical detector known has been tried in an array but by far the most 
common are CCD detectors. The CMOS process (complementary metal oxide 
semiconductor) is also being used to build array detectors out of silicon. These arrays 
tend to have all the necessary preliminary circuitry on the same chip as the array. 
CMOS devices have a smaller dynamic range than CCD detectors but they have the 
potential of being cheaper than CCD devices. It is expected that CMOS arrays will 
become the dominant type in applications that do not require the dynamic range 
available in the CCD technology. Other array types are being used primarily for long 
wavelenght IR work, where silicon's spectral characteristics are deficient.
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Your probably more familiar with the idea of electrical frequency; cycles per 
second of voltage or current. Spatial frequency is similar except the cycles 
are not measured per unit time but rather per unit distance. Lines per mm is 
a common unit of spatial frequency. 

The term spatial frequency is used as a way to characterize the complexity of an 
image or the potential for fidelity of a detector or reproduction technique.

Spatial Frequency

If we chose a 10% criteria we would end up with a dimension of 43 mm or a 
little more than an inch and one half. The truth would lie somewhere in 
between. The point being the pixel size ultimately limits the resolution of the 
detail of any image.

nearly half a meter!L 431.055 mm=L 100 pixel⋅ δL⋅:=

Following the argument we used above we need more than one pixel to represent 
an object with fidelity. If we chose a one percent rule. This would mean that the 
smallest object from this scene we would expect to be distinct would have a 
dimension of about.

δL 4.311
mm

pixel
=δL

2.207 m⋅

512 pixel⋅
:=

A target with a diameter of 2.207 will fill the entire  512 pixel dimension, therefore:

dia 2.207m=dia 2 Z⋅ tan
Θv

2









⋅:=

S 3.826 m
2

=S π Z tan
Θv

2









⋅








2

⋅:=
Z 3.5 m⋅:=Θv 35 deg⋅:=

Problem: Estimate the smallest object that can be resolved with high fidelity if the 
optical system has an angle of view of 30 deg and the focused field of view is at a 
distance of 3 m. 

A representative CCD pixel would be 20 µm or less on a side; so a common 512 x 
512 array would have an active area with a side dimension slightly larger than 1 cm 

and an area of about 105 mm2. 

Practical Considerations:
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A complex image with many changes from dark to light over a short distance 
will have high spatial frequency content. Where as an image of a uniformly 
illuminated flat surface will have zero (dc) frequency content. Most images 
have regions of high and low spatial frequency content. A detector with a 
large pixel density will reproduce high spatial frequency with greater fidelity 
than will a detector with fewer pixels per unit area. This is illustrated by the 
images below.
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The graph above illustrates brightness cycles imaged onto a detector 
with 256  horizontal pixels. For illustrative purposes the signal has a 
varying frequency that increases from left to right. The picture below 
illustrates the detectors displayed output.

If the same image were focused onto a detector with 64 horizontal 
pixels, a 4:1 reduction, your would obtain the results illustrated below. 
Note the relative compression of the higher frequencies and the distortion 
of the wave shape.
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The picture illustrates the choppy appearance of the sine wave peaks and the 
decreasing intensity from left to right as spatial frequency increases.

Summary:

The pixel is the smallest element of an image, the fidelity of reproduction is a 
function of the pixel size relative to the size of the feature being reproduced 
on the image plain. The smaller the pixel is relative to the feature the higher 
the fidelity of reproduction.

This fidelity is sometimes characterized in terms of the spatial frequency of the 
image. Low pixel counts will attenuate the higher frequency content and 
distort the original signal. 

High fidelity comes with not only a higher economic cost but also a slower 
frame rate. It takes longer to extract the image data from a high pixel density 
detector array.  
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Calculation Problems:

1) A detector has 64 pixels on a side and is used with a lens system that has an 
angle of view of 20 deg focused at a distance of  4 m. What unit of length does one 
pixel encompass?

2) Your detector is 4096 x 4096 pixel array. If you want to resolve a one 
meter distance with at least 20 pixels from an altitude of 3 miles what focused 
angle of view will you use? How big will the field of view be?

3) If the dynamic range of you detector is 3000:1 and you are going to map 
amplitudes to an eight bit system ( 0 -255 ). 
A) If each change of one represents the same change of  flux how many flux units 
does each step represent? 
B) How much greater is the average flux level at eight bit 200 than it is at eight bit 
20?

4) If a detector has a quantum efficiency of 87 from 400 nm to 980 nm. How much 
bigger is the signal caused by one microwatt at 980 nm than the signal caused by 
one microwatt at 400 nm? 

5) A detector and its Analog to digital conversion circuit has been set up so that 
the brightness area on the image will cause a digital number of 253 and the 
darkest area will cause a digital number 5. An white to dark edge crosses 10 
pixels darkening the percent areas indicated in the list below. Determine the 
digital number that each pixel will generate:

Percent dark

n 0 9..:=

6 On the attached Kodak data sheet Sensor # TH-7887A is specified at three 
different bit rates and their corresponding frame rates.

A) Convert each bit rate to the total number of gray levels.
B) Calculate the relative number of gray levels for each bit rate with respect to the 
eight bit rate.
C) Calculate the relative frame rate for each bit rate with respect to the eight bit rate.
D) What do you observe about the relative values? 
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L1 Gray Scale Image Modification:

Refer to attached documents: L1_theory and L1_example 

Materials:

One faded Black and white photograph.
One Zip disk

Equipment:
Scanner
Computer terminal with Mathcad installed.

Objectives: To observe how altering the numerical values of an image's pixels can 
alter the perceived image. To observe how the brightness and contrast of an image 
change as the histogram of the image changes. To improve the appearance of an 
image by altering its pixel values using a linear function.

Procedure Refer to example file through out:
1) Create a folder on zip disk named L1.
1) Scan image and save a a "bmp" file in folder L1 on zip disk.
2) Open a Mathcad file and save it in folder L1 on zip disk as "L1_lastname.mcd" 
3) Read image file into Mathcad using the READ_IMAGE command.
Example:

Q READ_IMAGE "Great-Grandma.bmp"( )=

4) Use the insert Picture command to display image as a picture.
5) Determine the maximum and minimum pixel values of the image and create a 
histogram. Plot the histogram for the image. 
6) Construct a straight line function to alter and improve brightness and contrast. 
Be sure your function does not cause any calculated values larger than 255 or 
smaller than zero.
7) Create a new image matrix using your function.
8) Use the insert Picture command to display the new image as a picture.
9) Determine the maximum and minimum pixel values of the new image and 
create a histogram. Plot the histogram for the new image.
10) You may have to experiment a little with the slope and intercept values of you 
function to optimize the final picture. An average brightness of 155 t0 165 
generally yields and acceptable image. ( Be sure you stay inside 0 to 255 range)
11) Hand in a print out of your work and the zip disk at the end of the period.

Key Mathcad commands you will use in this lab:
max min mean hist rows cols READ_IMAGE

Menu commands
Insert > Picture Insert > Graph File > Save As
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Theory for laboratory exercise L1

This document discusses and illustrates using the histogram approach to alter 
image brightness and contrast.

Pixel Intensity values on original image X
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Illustration of altering original
Pixel values by adding fifty. The
slanted dashed line is called the
function line. In this case it has

a slope of one and and
intercept of fifty.

This process will be illustrated below with a simple image of vertical bars with 
gray scale values of 50, 100, and 150.
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Add fifty to all image pixels

pic1i j, 50 Pic1i j,+=

Modified image pic1
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Statistical parameters and images:

mean Pic1( ) 98.611= stdev Pic1( ) 38.163=

mean pic1( ) 148.611= stdev pic1( ) 38.163=

Note that adding a constant changes the average but not the standard 
deviation. The average brightness changes but the contrast difference 
between the bars remains constant. If you want to alter both brightness and 
contrast you must use transfer function line with a slope greater or less than 
one.
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For the brightness change illustrated above the function used was:

Y X b+= where b was the added constant.

To alter both brightness and contrast you would use the function:

Y m X• b+= where the slope factor m alters the contrast.

For example lets make it our goal that pixels that have a value of fifty get 
changed to 25 and those that have an original value of 150 get changed to 
200. 

200 m 150• b+=

25 m 50• b+=

therefore: m
200 25−
150 50−

:= m 1.75=

b 25 m 50•−:= b 62.5−=
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Illustration of altering original
Pixel values by using the

function.

Y = 1.75 x X+ (-62.5)

-50
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pic2

mean pic2( ) 110.069=

stdev pic2( ) 66.785=

Both average and standard deviation are 
changed by this transfer function.
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L1_example: Great Grandmother enhance dress detail:

Q READ_IMAGE "Great-Grandma.bmp"( ):=

Numerical parameters of image matrix

max Q( ) 77.000= min Q( ) 31.000= rows Q( ) 356.000=

cols Q( ) 180.000= mean Q( ) 58.265=

Define Histogram horizontal axis "int" and evoke Mathcad histogram function

x 0 255..:= intx x:= H hist int Q,( ):=

Display Image and Histogram

Insert Picture Q

Q
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H1 hist int Q1,( ):=mean Q1( ) 160.400=Q1 m Q⋅ b+:=

Use function to create new image Q1.

b 118.261−=b Ymin m Xmin⋅−:=

b 118.261−=b Ymax m Xmax⋅−:=

m 4.783=m
Ymax Ymin−
Xmax Xmin−

:=∆Y m ∆X⋅ 0+=

Ymin m Xmin⋅ b+=

Ymax m Xmax⋅ b+=

Solve for slope coefficent "m" and intercept coefficent "b". 

Ymax 250:=Ymin 30:=

Select Desired new values of X which will be the Y values of the conversion function.

Xmax max Q( ):=Xmin min Q( ):=

Map original Gray Scale values to new Gray scale values using a y = mx + b function.

Line fit
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H2 hist int Q2,( ):=Q2i j, Q1i j, Ai j,+:=

Create new image Q2 by adding random number matrix to image Q1.

max A( ) 4.000=min A( ) 4.000−=

Create a matrix of random numbers using the rnd 
function and the ceil function.

Ai j, rnd 4( ) 1−( )
ceil rnd 4( )( )⋅:=

cols Q1( ) 180.000=

Max 356.000=Max rows Q1( ):=

j 0 cols Q1( ) 1−..:=i 0 rows Q1( ) 1−..:=

An optional "improvement" to the image is to fill in these gaps. This is done by adding and 
random numbers in the range negative four to plus four to each pixel.  

110 115 120
0

2000

4000

6000

H1x

intx

Q1

Note that the slope of 4.783 causes empty 
spaces about 5 Gray Scale levels wide.

New Image
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Final image and histogram
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